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Preface 
 
 
 
The documentation and botanical exploration in Papua New Guinea as it is known 
today is a result of efforts made by many botanists, foresters, researchers, 
agriculturalists, lecturers and their students. Many institutions have supported this 
efforts by way of providing resources, logistics and technical assistants to many long 
term and short term researchers and scientists both residents and non residents. 
 
Botanical explorations in PNG remain the most challenging both physically and 
culturally. Much of the forest areas in Papua New Guinea remain to be explored 
botanically due to inaccessibility and isolation. The plant collections made under this 
project will come from sites that had not been explored in the past and these will 
increase the number of herbarium collection significantly. 
 
The methodology for documenting, collecting and preserving plant specimens remain 
the same over the years except for recent improvement in preservation techniques for 
samples for DNA studies, which provides the basis for phylogenetic studies and 
taxonomic classification. 
 
This manual was prepared to assist forestry officers and scientists collecting and 
documenting the flora of Paua New Guinea in the Multipurpose National Forest 
Inventory project. It focuses on field collection techniques and laboratory processes to 
ensure that plant specimens are sampled correctly in the field and that they are 
processed correctly after it is received in the laboratory. 
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1.0 Introduction 
 
This manual is provided as an easy reference for the implementation of the 
Multipurpose National Forest Inventory (MNFI) in Papua New Guinea. It focuses on 
sampling methods designed for sampling plant materials under the project for higher 
plants, lower plants, lianas, and leaf traits. The standard botanical collection and 
processing procedures are described when sampling materials in the field and 
processing in the laboratory. 
 
The manual describes the equipment to be use when collecting plant samples in the 
field, how to collect samples, how to describe a plant in the field and write the notes 
into the field note book, how to collect floral and fruiting materials, how to preserved 
samples in alcohol and stored in the field and how to packed specimens and send 
them to the herbarium at the Forest Research Institute (FRI) for processing. 
 

The manual also described methods for collecting samples of different plant groups. 
Some plant groups have larger leaves and are difficult to collect specimens in the field. 
The different methods for collecting these plant groups are detailed in the manual. 
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2.0 Botanical collecting tools and equipment 
 

 
Sufficient tools and equipment are required for collecting and preparing plant samples 
in the field. A good plant specimen will enable the botanist make an accurate 
identification on a plant species sampled and therefore maintain the quality of the data. 
The following tools and equipment are required for field collection and must be 
available when working in the field. 
 
 
 
Figure 1. Equipment for collecting and preserving plant specimens 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2. Equipment used for recording data on plant specimens 
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Figure 3. Sling shot (catapult) use for collecting samples from canopy trees. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.0 Plant samples collected from the NFI clusters 
 
Plant specimens collected from the plots/clusters under the NFI project will be 
processed and stored for further study and confirmation of species names. It is 
anticipated that most of the samples will be sterile and therefore will take time to 
confirm their species names. In the lab, the specimens will be dried and stored before 
they are identified. 
 
Incoming specimens will be processed and identified immediately after they are 
received from the field. The lab will cater for general specimens as well as samples 
collected for Leaf Area and DNA studies. 
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4.0 Sample numbering and labelling 
 

The number of specimens in the field is very important because it is the only way to 
track specimens and data back to their correct plot and cluster. The Tag will be used 
on both sides and the following procedure will apply to: Upper Plants; Super Plots; 
Lianas; Regeneration; and Vegetation Cover, Leaf Area and DNA. 
 
Using Cluster 108924 and Centre Plot at Radius 3m as an example, the following 
applies; 
 
1. Upper Plants 
 

Side 1:   108924 - C   Side 2:  R3 – NE - Spec # 
    

    

 
Where 108924 is Cluster No, C is Centre Plot Id, R3 is Radius 3, NE is North-East Direction, Spec # is 
Spp No 
 
2. Super Plots 
 

  Side 1:         108924 - C      Side 2:     SUP – SEG 1 – Spec # 
 
Where 108924 is Cluster No, C is Centre Plot Id, SUP is Super Plot, SEG 1 is Segment No, Spec # is 
Spp No 
 

3. Lianas 

Side 1:      108924 - C    Side 2:  L – R3 - Spec # 
    

 
Where 108924 is Cluster No, C is Centre Plot Id, L is Liana, R3 is Radius 3, Spec # is Spp No 
 
4. Regeneration 
 
                                   Side 1:             108924 – C         Side 2:         REG – N - Spec # 
 
Where 108924 is Cluster No, C is Centre Plot Id, REG is Regeneration, N is North Direction, Spec # is 
Spp No 
 
5.        Vegetation Cover 
    

                          Side 1:         108924 - C     Side 2:       VC – R10 – Spec # 
 
 
Where 108924 is Cluster No, C is Centre Plot Id, VC is Vegetation Cover, R 10 is Radius 10 or 15, 
Spec # is Spp No. 
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6. Leaf Area 

Side 1: 

 
 
108924 - C Side 2: 

 
 
LA – R3 – Spec # 

 
 
Where 108924 is Cluster No, C is Centre Plot Id, LA is sample material, R3 is Radius 3, Spec # is Spp 
No. 
 
7. DNA Samples 
 
 
                                               Side 1:     108924 – C           Side 2:          DNA – R3 – NE - Spec # 
 
 
 
Where 108924 is Cluster No, C is Centre Plot Id, DNA is sample material, R3 is Radius 3, NE is North-
East Direction, Spec # is Spp No. 
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Table 1. Equipment for collecting and sampling plant samples per team 
 

 Item Quantity Purpose 
    

1 Secateurs 2 Use to cut and trim a specimen in the field 
    

2 Field note book 2/person Record field characters of specimens 
    

3 Specimen tags 1 box Tag all specimens with field numbers 
    

4 Pencil 1 Use pencil to write on tags and field books 
    

5 Old newspapers 1 bundle To cover and separate specimens 
    

6 Plant press & straps 2 To  press  specimens  before  preserving  in 
   alcohol 
7 Plastic bags (polythene) 20 To store and preserved specimens 
8 Pruner 1 To collect samples from higher branches 
    

9 Bush knife 1 To slash the bark of trees to view exudate 
   and texture 
10 Safety helmet 1 Wear helmet when using the sling shot 
    

11 Binoculars 1 Identify trees in the canopy 
    

12 Camera 1 Take image of specimens 
    

13 GPS 1 To record Lat/Long and elevation of sites 
    

14 Batteries 1 Box Spare batteries 
    

15 Clip Lock Bags 1 Packet Storing samples 
    

16 Tape measure 1 Take measurement of trees 
    

17 Dissecting kit 1 confirming anatomy of flowers and fruits 
    

18 Hand lens (X 10 / 12) 1 Closer view of character states of flowers, 
   hairs, and spores 
19 Sling shot (Catapult) 1 Collect samples from canopy trees 
    

20 Hand gloves 1 Use for collecting thorny plants 
    

21 Fishing line reels 1 To tie the sinker and shoot over a branch 
    

22 Nylon twine (4mm thick x 1 Pull down branches for sample 
 150m long)   
    

23 Sinker (0.1kg lead) 10 Use to shoot a line over a branch 
    

24 Ribbons 10 Use to tag/ demarcate sections in plot 
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5.0 Materials to be used for preserving plant samples in the field 
 
 

Use a plant press and a strap to prepare materials for preservation with 75% 
ethanol. For flowers and fruits, these can be preserved in small jars filled 
halfway with ethanol, the jars must be airtight and lids further secured with 
heavy duty masking tape. For DNA materials, these can be stored in filter 
papers with labels and stored in small jars with dried silica gels and properly 
labelled on the outside. 
 

1. Plant presses (wooden) & straps 
 

2. Card boards 
 

3. Ethanol (75%) 
 

4. Collecting vases for spirit material 
 

5. Silica gel 
 

6. Masking tape 
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6.0 General collection of plant specimens 
 

Collecting plant samples for preservation in the herbarium is a skill that gets better 
with more field collections. It is important that all samples collected as herbarium 
specimens or for identifications be fertile so the botanist can use all the features to 
identify the plant and have its correct species name placed on the specimen. 
 
Fertile specimens are samples with fruit and flowers whilst a sterile specimen is one 
without a fruit or flower. The fruit or flower may be separate from the specimen 
however; they must have the same tag number. In many cases plants may not be in 
flowering or fruiting season, then all effort should be made to collect a good plant 
material with complete leaves and habit. 
 
A botanical or plant specimen is not just a single leaf, a half leaf or fragments. A good 
plant specimen should have at least some leaves attached to the twigs or even better 
if the flowers and fruits are present. 
 

It is important to note that different plant groups (angiosperms, gymnosperms, 
monocotyledons, pteridophytes, bryophytes etc.) will have different collection 
methods. These methods ensure that samples collected have the correct features that 
will be use to differentiate and identify one species from another. 
 
The following are basic procedures to follow when collecting plant samples in the field. 
 

1. Look for a branch with flowers and or fruits on it and collect a twig of a 
branch that has good leaves, flowers and or fruits. 

2. Make at least 3-5 specimens per tree. 
3. Tag the specimen with a tag and write the collection number on the tag. 
4. Wrap the specimens in a newspaper and place in a collecting back 

 
5. Measure the dbh and height of the tree and take notes of its habit, 

buttress, bole, bark characters, exudate, branching and canopy. 
 

6. Describe the general environment in which the plant was collected from, 
soils, topography, forest type, and elevation and GPS location. 

 
7. If live materials are collected, such as seeds, rhizomes, cuttings or 

wildings for planting, these should be tagged and given the same tag 
number as that of the specimen voucher. 

 
8. If plant samples are collected for DNA studies, these materials should be 

place into the sampling jar with silica gel and given the same voucher 
number. 
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Figure 4. Collecting and preserving plant samples. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.0 Sampling trees using a catapult 
 
In the past specimens from very tall trees were collected using rifles and shot guns by 
gun men, they aim at the branches with flower and fruits and shoot bring down the 
branches. The method is no longer used in PNG due to risks involved. Long pruners 
were used for taller trees but can only reach certain height depending on the number 
of extensions to the pole. Climbers were often used but only for smaller trees. 
 
 
The alternative method introduced to PNGFRI in the mid 1990s by a former director 
Dr. Geoff Stocker was a sling shot or catapult method (Damas, 2014). 
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This method of collecting samples uses a lead (sinker) tied to one end of a fishing line 
( approx. 21lbs) and is shot up to a branch of a tree. The branch must have flowers 
and or fruits. The sinker goes over the desired branch and it is lowered down to the 
ground, then the sinker is removed from the string and the string is tied to a nylon 
twine and pulled up over the branch until that end of the nylon twine reaches the 
ground. The string is removed and both ends of the nylon twine held together and pull 
until the branch breaks. 
 

The catapult or a sling shot method will have the following components (see Figure 3). 
 
1. 21 lbs fishing line approximately 150 m long. 
2. Fishing line reel (large size) 
3. Fishing line reel (medium size) 
4. Sinkers (lead) 
5. Sling shot (Catapult) locally made 
6. Nylon twine ( 4mm thick and 150 m long) 
7. Hand gloves 
 
 
 
 

8.0 Preserving plant samples 
 
At the end of each day, all collections made must be put into press and ready for 
preservation the following day. Plant samples (voucher) are to be trimmed to fit into a 
one page of a newspaper, tagged and place into a plant press, interspacing each 
collection with a cardboard to ensure specimens are pressed flat and ready for 
preservation. Tie the plant press with a strap or cord and press down equally on all 
sides ensuring that the force is evenly distributed (Womersley, 1976). 
 
After 24 hours, remove the specimens from the press, remove the cardboards and tie 
the specimens as a bundle. Place the bundle of specimens into a polythene tube and 
add 3-4 cups of 75% ethanol, ensuring that all specimens are treated. Shake the 
bundle to allow the ethanol to spread evenly and seal the tube with a masking tape. 
Ensure that the bundle is air tied and the ethanol is not leaking. 
 

The following tasks are to be followed when preserving the specimens; 
 

1. Trim the samples to fit into a newspaper and tag the first voucher. 
 
2. Make botanical notes of the specimen into a botanical field book. 

 
3. Place the collections into the newspaper and turn a few leaves to show 
the under-surface, do this to all samples collected. 

 
4. Separate each collection with a cardboard. 

 
5. Place the collections into a plant press and tie with a strap or cord. 
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6. Leave for 24 hrs and then transfer the specimens from the press into a 
polythene tube. 

 
7. Treat the specimens with 75% ethanol (3-4 cups) and seal the bag with 
a masking tape. 

 
 
Figure 5. Preserving plant specimens in the field 
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9.0 Collecting samples of non-tree plant groups 
 

Some groups of plants such as palms, pandanus, grasses, gingers, aroids, ferns, 
bananas and lianas have their own collection methods. General rule is botanical 
specimen must always be fertile. 
 
Palms, pandanus, gingers, bananas, aroids and some grasses are difficult to collect 
because of their sizes, only certain parts of the plants will be useful for collecting so 
long as their distinguishable features are present for identification. Example, the palms 
are too big and bulky so the fronds will be measured and several sections will be 
discarded and only the selected sections be maintained as samples. The 
inflorescence will be quiet bulky so only several sections will be selected and rest will 
be discarded. 
 

10.0  Collecting palms (Arecaceae) 
 
Palms habits and forms vary in many ways particularly the leaf structures and 
architectures are somewhat complex that making specimens are always tedious, time 
consuming and often it is bulky. It is recommended that the parts that are useful for 
distinguishing species must be observed and collected carefully as in all the other 
plant species. 
 
Figure 6. Pictures showing different types of palms 
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Figure 7. Pictures showing different leaf types 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Procedures for making palm specimens: 
 
1. Take a photograph of the plant and each entire part before sectioning. Place a 
common object such as a pencil in the photograph to provide scale. 
 
2. Sampling leaves: 
 
a. Measure the petiole, blade, rachis and leaflet lengths of pinnate leaves, 
the petiole and blade length of palmate (segments radiating from a single point) leaves 
and the petiole, blade and rib lengths of costa palmate (leaf stalk extending into leaf 
blade - rib) leaves. 
 
b. If leaves are small, keep and press whole leaf. For large leaves divide 
the petiole into mounting paper size pieces. Number the pieces on the tags to keep 
them in order of cutting. 
 
c. Pinnate leaf: Take several pieces from the blade, include tip. For each 
piece, apart from the tip, cut the rachis into a mounting sheet size length, remove the 
leaflets on one side leaving the stubs near the rachis. Fold the other side back and 
forth to fit the mounting sheet. 
 
d. Palmate leaf or costa palmate leaf: Keep the point of attachment to the 
petiole and ensure that the hastula is showing. Cut off one side of the blade, part of 
the other side and fold several times to fit the mounting sheet and press. 
 
e. Inflorescence: If the flower cluster is small, fold and press all of it. If it is 
large, keep several portions including the base and also showing the origin of the side 
branches in successive order. If applicable try to keep an entire inflorescence main 
stem with the side branches removed. Selected side branches from noted positions 
should be kept and pressed. 
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f. All of the spathe should be kept, cutting it into sections if necessary. 
Some flowers may be preserved in ethanol (spirit). Fruits should be treated as for 
flowers. The cupule (or cup) at the base of the fruit should be kept. Large fruits may 
be dried quickly if cut in half. (BAKER, W. J. & DRANSFIELD, J. 2006 and BARFOD, 
A. S., BANKA, R. & DOWE, J. L. 2001) 
 
 

11.0  Collecting Ferns 
 
Ferns are easy to collect, especially the smaller groups of fern species. But one must 
keep them out of sunlight in the field as their fronts can wilt easily. Larger ferns are a 
bit difficult but one gets better every time new collections are made. 
 
Figure 8. Frond of a fern 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9: Rhizomes of terrestrial ferns (Source; Jones, D.L. and Clemesha, S.C. 1976) 
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The following steps are to be followed when collecting ferns. 
 

1. Select a section with some new growth, good healthy fronds with spores 
on the under surface. Collect several plants from the same population and 
treat them as one collection. 

 
2. Tag the specimen and give a voucher number 

 
3. Wrap the sample, keep it moist and place it in a collecting bag. 

 
4. Press the specimens as soon as you reach the camp as some ferns can 
lose a lot of water and wilt and will be difficult to spread out on the press. 

 
5. For large ferns such as Cyathea and Dicksonia, collect the base of the 
frond (10 cm), cut the first 10-15 cm of the petiole from the base, cut a 10-
15 cm from the centre of the frond and the last 15 cm from the tip. 

 
 
 

12.0  Collecting herbs and grasses 
 
Herbs are small plants that are rarely taller than 1 m in height and can grow as an 
individual within population or may be part of population that colonizes an area 
vegetatively. Herbaceous plants are easily collected because a whole plant can be 
collected by either cutting the plant at the base or uproot the plant if it is not too bulky. 
The following steps are to be followed when collecting herbs. 
 

1. Select healthy individuals from the population, ones with flowers or fruits 
 

2. Cut at least 3-4 individuals measuring 10-30 cm in length 
 

3. Tag them and wrap all samples as one collection and place into a collecting 
bag 

 
4. Describe the habitat, ecology and get the elevation of the site where the 

plant was collected. 
 

5. Press the specimens as soon as you reach the camp as some herb species 
are succulent plants and can dry up and wilt and will be difficult to spread 
out on the press. 
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13.0  Collecting gingers 
 

Gingers are considered as large herbs but some species are smaller in size and can 
be easily collected, especially the epiphytic species in high altitude forests. Some 
species have terminal inflorescences whilst other bears flowers and fruits at the base. 
In general a specimen with a flowering or fruiting materials would be sufficient to 
identify to the generic level. For a good species description, specimens should include 
a stump with a rhizome, the first 3-5 leaves, another 3-5 leaves from the centre and a 
terminal twig (20 cm) with flowers or fruit. 
 

The gingers are group according to their flowering habits, one group possess terminal 
and axillary inflorescence while the other group bearing basal inflorescence. In Papua 
New Guinea the genera bearing terminal or axillary inflorescence include Alpinia, 
Ridelia,Tapeinochilus Boesenbergia, Pleuranthodium and Curcuma. The other genera 
with basal inflorescence include Amomum, Hornstedtia and Etlingera. 
 
Figure 10. Ginger species 
 
 
 
 
 
 
 
 
 
 
 
Figure 11. Collecting Gingers in the field. 
 
 
 
 
 
 
 
 
 
 
 
 
The following steps must be followed when collecting gingers: 
 

1. Photograph the plant and each entire part before sectioning. Place a 
common object such as a pencil in the photograph to provide scale. 

 
2. Collect the best fertile (flowers and fruit) sample of a species from that 

population or clump, 
 

3. For species with inflorescence attached to rhizome, dig the base 
carefully to avoid breaking any attached inflorescence, flowers or fruits. 

 
4. The rhizome dug out from the ground be cleaned off the mud from the 

roots with water. Remove soil with care to avoid breaking the flowers. 
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5. Specimen collection will include rhizome (split in haves), flowers, fruits, 

middle leaf and top leaf attached to the pseudo stem 
 

6. For species with terminal and axillary inflorescences carefully prepare 
the specimen to fit in between newspaper page 

 
7. The leaves specimen should include top section, mid-section and the 

lower section of the pseudostem. 
 

8. Described the species noting the following; life-form; i.e. terrestrial or 
epiphytic; habit i.e. clump or spreading, length of pseudostem; colour of 
flowers and fruits, position of fruit, 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
21 

 



 

14.0  Collecting bananas 
 

A good collection of a banana (Musa sp.) comprises herbarium sheets of pressed 
material, written notes, spirit material and photographs (whole plant, pseudo-stem (to 
show colour), whole inflorescence, bracts and male flowers). Measurements to be 
taken include total height of the plant, diameter of the stem, total leaf length and with, 
length of petiole, size of fruit and seed etc. 
 
Figure 12. Banana plant and fruit with male flowers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 13. Banana (Musa) leaf showing sections for collection. 
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It is recommended that the leaf specimen must be collected from the fourth-last fully 
developed leaf below the inflorescence. 
 
 
Procedure for collecting specimens of banana plants 
 
 

1. Materials to be collected include half lamina base + midrib. 
 

2. Upper section of petiole (junction between lamina and petiole should form 
the middle of the herbarium sheet), exclude the top of the leaf and bottom 
of the petiole 

 
3. Split petiole in half, longitudinally and cut off one side of the lamina leaving 

the midrib intact so that what remains will fit onto a herbarium sheet. 
 

4. Take one 'hand' of fruits and cut in longitudinal section of one fruit 
 

5. Take one cluster of male flowers, attached to the subtending bract portion 
of the male peduncle (the hanging 'tail' between bunch and male flowers), 

 
6. Describe the plant, taking notes of the following; plant suckering freely or 

hardly suckering at all; colour of sap in suckers (watery, or red to violet, or 
milky), colour of pseudo-stem; older bracts strongly revolute or scarcely 
revolute, inflorescence erect or pendulous, total length of lamina and 
petiole, colour of fruit, colour of male flowers. 

 
7. For spirit materials, use a large screw-top glass jar. Include some male 

flowers, some female flowers, some fruits and a bract. This can be done 
back in the laboratory. 
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15.0  Collecting cycads (Cycadaceae) 
 

Cycads are mistaken for palm or a tree fern because of their morphology especially 
the leaves (fronds) and their stems which almost resemble palms and tree ferns. 
However the inflorescence differ from palms and ferns as they are cone bearing plants. 
Palms bear flowers while the ferns produce spores. 
 
 

Figure 14. Cycas tree leaves, fruits and cones 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Procedures in collecting cycas specimens: 
 

1. Take pictures of whole plant, leaf (frond), flowers (cones) and fruit. 
 

2. Measure total height of the plant, diameter of the stem, total leaf length 
and width, length of petiole, size of fruit and seed etc. 

 
3. Specimens will include a cone or at least a number of the sporophylls 

(scales) that make up a cone, an entire leaf (i.e. the entire "frond", not just 
an individual pinnule (leaflet), leaf may be cut into c. 30 cm lengths for 
ease of handling. 

 
4. Total number of leave present in the crown of the plant. 
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16.0  Collecting bamboos (Poaceae) 
 

Bamboos comprise a section of the very large grass family Poaceae. Many species 
are in excess of 5 metres tall and some can reach 30 metres or more. One of the 
characteristics of most bamboos is that they rarely produce flowers, and so when you 
collect a specimen, the chances are that only sterile material will be available. 
 
Figure 15. Picture showing bamboo culms 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will need to collect the following: 
 

1 Photograph the plant and each entire part before sectioning. Place a common 
object such as a pencil in the photograph to provide scale. 

 
2 A leaf sample from a terminal shoot. 

 
3 Sample of the stem or culm about 30cm long (you will probably need a small 

saw to remove this), and one or more culm sheaths. 
 

4 Collect flowering sprigs if the flowers are present 
 

5 Record whether the species is tightly clumping, or ‘running’; the stem colour 
and any striping, overall height, and the branching pattern at the nodes. Also 
note from which part of the plant you collected the stem section and the culm 
sheaths. 
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17.0  Collecting DNA samples  
 
While working on the field, selected plant families and genera will be sampled to collect 
material for DNA analysis: a number of leaf samples, selected from young growing 
buds, would be ideal. For this purpose, each team with a botanist or a staff member 
from the herbarium will have a copy of the list of selected taxa for the DNA sampling. 
To check the field identification it is a good practice to collect also a specimen for 
certain identification in the herbarium. 
 
The major aim when collecting material for DNA analysis is to get the plant specimen 
to dry as quickly as possible, to avoid degradation or the onset of decomposition 
processes. For this reason, it is important to increase the surface area for water 
transpiration by cutting the leaves into smaller pieces. According to (Doyle 1991) it is 
preferable to also remove the midrib from the leaves before storing them.  
 
To preserve the material, the leaves’ fragments should be first inserted in an empty 
tea bag, which allows transpiration, labelled as the specimen from which the leaves 
are taken, and then stored in a larger container filled of silica gel, that will absorb the 
moisture and can be changed with ease when needed. The use of tea bags avoids 
the need to carry large amounts of silica gel and zip-lock plastic bags. Moreover it 
makes the replacement of silica gel easier (Wilkie et al. 2013). 
 
 
Summary of the DNA sampling procedure  
  
1 Identify the species to sample, take a specimen for taxonomic identification and label 
it. 
2 Take a sample for the DNA analysis. If possible select young leaves that have no 
defects, like insect attacks and galls. Lichens and other dirt on the leaf surface must 
be removed. If the leaf is wet, wipe the leaf surface before storing it.  
3 Carefully tear or break the leaves with your fingers into smaller pieces and place 
them in the tea bag. We recommend collecting 4–6 grams of fresh leaf material torn 
into pieces not exceeding 2 cm2. If possible, try to take several samples.  
4 Label the tea bags with the corresponding specimen number by inserting a collector 
label placed against the wall of the bag so that it is easily legible (Fig. A).  
5 Place the tea bags in an airtight container and completely submerged in silica gel 
until completely dry (Fig. B). This operation has to be done without delay.  
6 The container should be shaken frequently over the first day to make sure that silica 
gel is always in close contact with the plant material. Once the material is completely 
dry, the teabag can then be removed from the silica gel and placed in an airtight 
container which has a fresh layer of silica gel at its base (Fig. C) for longer term 
storage.  
7 NOTE: If the specimen has succulent leaves, it is recommended to peel and store 
only the leaf surface.  
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Materials needed for DNA sampling  
 
1 Silica gel  
2 Empty tea bags  
3 Collector labels and marker  
4 Small containers for drying  
5 Bigger airtight container for long term storage  
 
 
 

 
 
 
 
Fig. A. Ripped leaf material placed in teabag with internal paper label. B. Teabag submerged in silica gel (regularly 
shaken). C. Longer term storage of teabags in sealable container with layer of silica gel at base. (Photos: P. Wilkie) 
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18.0  Packaging and Posting Specimens to LAE Herbarium 
 

All collections to be forwarded to the Forest Research Herbarium (LAE) must be 
packed and posted as follows: 
 

1. Specimens are to be packed into polythene bags and sealed with a heavy 
duty masking tape. The package must be completely sealed and air tight. 

 
2. The package must be packed in sequence by collection numbers and date 

of collection. 
 

3. Each package must be label with; cluster number, plot, district, province and 
team name. 

 
4. Place the package into a carton and sealed off using a heavy duty masking 

tape. 
 

5. Label the box with a proper forwarding address. 
 

6. Place the field books in an envelop and forward to the FRI Director, attention 
to the Botanists 

 
 

19.0  Processing and Storing Plant Samples in the Herbarium 
 
When specimens arrive in the herbarium, these will be registered, processed and dried 
in the oven dryer for 48 hours or longer if materials are bulky. The specimens will then 
be identified using the reference collection in the herbarium, field labels typed and 
place onto each specimen. 
 

All fertile specimens will be mounted and incorporated into the herbarium and 
duplicates forwarded to other collaborating institutions. 
 

The confirmed list of botanical names for each cluster will be forwarded to NFI/PNGFA 
HQ for correction and databasing. 
 

Specimens received in the herbarium are to be managed in a way that can be easily 
tracked and checked when the need arise. The following steps will be followed; 
 

1. Register all incoming collections in the Log Book. 
 

2. Store the incoming specimens in the lab according to the Cluster Numbers 
 

3. Process specimens by Cluster numbers 
 

4. Remove specimens from their package and check for tag numbers, 
 

5. Place single specimen into a newspaper and separate each specimen with a 
cardboard, 

 
6. Use a strap to tie the specimen and place into the oven dryer. 

 
7. Set the dryer at 60 degrees and dry the specimen for 48 hours, 

 
8. Remove the samples from the oven dryer and remove the cardboards. 
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9. Identify the specimens and generate a list. 
 

10. Confirm the identification using the reference collection in the herbarium 
 
 

20.0  Field notes for NFI specimens 
 
All specimens collected must have a field note attached to the material. The field notes 
are records relating to that specific sample and will include information on habitat, 
locality, date, plant habit etc Staff working in the herbarium will re-type the information 
in the field books and attached to the specimens using the tag numbers. 
 

1. After the specimens are dried, locate and place the appropriate field book 
with the specimens. 

 
2. Type the notes in the field book into a computer and save under the cluster 

number as a file name. 
 

3. Change the botanical name if different from the identification made in the 
field. 

 
4. Print four labels to a sheet, photocopy and cut, and place on the specimen. 

 
5. File the specimens by clusters in the storage cabinets. 

 
 
 

21.0  Leaf Area Measurements  
 
The area of a leaf is the most common metric for leaf size and is defined as the one-
sided or projected area of an individual leaf, expressed in mm2. Remember that to 
prepare for the Leaf Area Measurements, the specimen samples have to be dried 
beforehand at a temperature of 60 degrees Celsius for 24 hours.  
 
To store and catalogue the images install the free license software ImageJ and follow 
this procedure 
 

1. Before the scanning of the leaves, create a folder for each cluster and store all 
the scanned images of leaves in the Cluster folder they belong to.   

 
2. Scan the leaves. More leaves for each image are allowed but remove the 

petiole from all of them and add a ruler in every scan. Note: The background of 
the image must be withe or clear, the leaves have to be clearly visible. 

 
3. Open ImageJ and follow this pathway: File > Open > Select the picture to 

analyse.  
 

4. Zoom in the image so that the ruler is clearly visible. 
 
 
 
29 

 



 

5. Use the “line” tool (fifth button in the console) to select 1 centimetre of length 
along the ruler and follow this pathway: Analyse > Set Scale > Know distance: 
1 > Global: check (this is needed only if all the images have the same size, true 
when you are scanning all the leaves in the same scanner) > Unit: cm > ok 

 
6. Change the colours of the image for an easier selection: Image > Adjust > 

Colour Threshold (or Threshold if you want to work with a B/W image)  
Note: if “only works with greyscale images” error appears, go to Image > Type > RGB 
Stacks (you will obtain a B/W image)  
 

7. Use the two levers in the Colour Threshold panel to select only the leaves. To 
do so, try to keep only the green peak in the colour distribution. Look for the 
best fit and close the panel. 

 
8. Open the ROI Manager to select the leaf blade: Analyse > Tools > ROI 

manager. 
Use the “magic wand” tool (the eighth button in the console) to select a single leaf on 
the image, then click “Add” on the ROI manager panel. Repeat for each leaf in the 
image. 
 

9. Click on “Measure” in the ROI manager panel and save the results in the correct 
Cluster folder using the field label as name. 

 
Once you have finished the scanning procedure, remember to store the samples by 
cluster into container and keep them in a cold storage area.  
Eventually update the species name after confirmation of the species. 
 
 

22.0  Processing leaf samples for DNA 
 

When materials for DNA analysis are received in the herbarium the following 
procedure will be followed: 
 

1. Register all incoming materials into a Log Book 
 

2. Record the following information base on the field label of the specimen: 
Species name; Specimen Number; Cluster Number; Date, Location; 

 
3. Place sample packages from each cluster into one container and label 

with cluster number 
 

4. Put containers in a refrigerator and store at 5-10 degrees celsius 
 

5. Enter the information in the Log Book into a database and generate a 
checklist for the samples collected. 

 
6. Update the checklist every month. 
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